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Important Information                         

Important Information  

 

  Thank you for purchasing the Expert II Cutting Plotter.  

Before you use the cutting plotter, please make sure that you have read the     

safety precautions and instructions below.  

              Caution

!

SAFETY PRECAUTIONS!  

 For safety concern, please always hold the cutter firmly from the bottom while moving 

it.  Do not move the cutter by clasping the depression area on both sides.  

 

                        

 

 

  

 Do not shake or drop the blade holder, a blade tip can fly out.  

 During an operation, do not touch any of the moving parts of this machine (such as the 

carriage). Also be careful to make sure that clothing and hair do not get caught.  

 Always connect the power cable to a grounded outlet.  

 Always use the accessory power cable which is provided. Do not wire the power cable 

so that it becomes bent or caught between objects.  

 Do not connect the power cable to branching outlet to which other machines are also 

connected, or use an extension cable. There is danger of overheating and of 

mis-operation of the machine.  

 Keep the tools away from children where they can reach.  

 Always put the pinch rollers within the white marks.  

O (correct)   X (Incorrect)   
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 Chapter 1  General Information 

 

1.1 Introduction 
Expert II series cutting plotters have been designed to produce computer-generated images 

or perform contour cutting on sheets or rolls of vinyl media. In addition to performing quality 

cutting on sheet or rolls of media, Expert II series cutting plotters can also be used as a pen 

plotter. 

 
This manual covers the following models of Expert II series cutting plotters: 

.Ex II-24 for media width: 50mm(1.97”) ~ 719mm(28.3”) 

.Ex II-24LX for media width: 50mm(1.97”) ~ 719mm(28.3”), with AAS function 

.Ex II-52 for media width: 50mm(1.97”) ~ 1470mm(57.9”) 

.Ex II-52LX for media width: 50mm(1.97”) ~ 1470mm(57.9”), with AAS function 

 
 

1.2 Package Items 
The package of Expert II contents the items listed below, please check carefully.  

If you find any item missing, please consult your local dealer for further assistance.  

 

 Item Quantity 
 Cutting Plotter 1 Set 
 Accessories 1 Set 

AC Power Cord 

 

Desktop Support Brackets 
(EX II-24/EX II-24LX only) 

 

Cutting Pad 

 
USB Cable (1.8m) 

 

Cushion in tool carriage 

 

Tweezers 

 
Paper Slicer 
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1.3 Product Features  
The followings are the main features of the Expert II cutting plotters: 

        ‧ Dual-port connectivity – USB & Serial interface. 

‧ Up to 350 gram cutting force.  

‧ Up to 705 (EXII-24(LX) / 635 mm (EXII-52 (LX)) per second cutting speed  

(at 45 degree direction.) 

‧ Guaranty 3 meter (10’) tracking. 

‧ Enhanced Automatic-Aligning System (AAS II) for auto contour cutting 

 (only for LX models.) 

 

1.4 The Appearance (EX II) 
1.4.1 The Front View  

 

 

 

 

Object Description 

A Primary Pinch Roller To help hold the media during cutting. 

B Slicing Groove To help slice off media. 

C Alignment Ruler To align media with clear guideline marks 

D Tool Carriage Performs the cutting or plotting with the installed blade or 

pen.  

E Blade Holder To hold the blade. 

F Platen The surface for holding and supporting media in operation. 

G Cutting Pad To protect blade and plate in operation.    

H Control Panel  To consist of 10 control keys and 6 LED lights. 

J Grid Drum To move media back and forth in operation 

Figure 1-1 



                                                                   Expert II User Manual 
 

 
General Information                                 1-3 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.4.2  The Side Views  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Object Description 

K AC Power Connector To insert the AC power cord. 

L Fuse 3 Amp. 

M Power Switch To turn on or off the machine. 

N USB Connector To connect the machine and a computer through a 
USB cable. 

O Serial Interface Connector To connect the machine and a computer through a 
RS-232 cable. 

K L M 

Figure 1-3 Figure 1-4 

N O 

J 

Figure 1-2 
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Chapter 2  Installation 

2.1 Precaution 
  Please read below information carefully before you start installation.  

 
Notice 1 

 Make sure the power switch is off before installing the cutting plotter.  

 Carefully handle the cutter to prevent any injuries. 

 

Notice 2  Choosing a proper place before setting up the cutting plotter 

Before installing your cutting plotter, select a suitable location, which meets the following 
conditions. 

 The machine can be approached easily from any direction. 

 Keep enough space for the machine, accessories and supplies. 

 Keep the working area stable, avoiding severe vibration. 

 Keep the temperature between 15 and 30℃ (60-86oF) in the workshop. 

 Keep the relative humidity between 25% and 75% in the workshop. 

 Protecting the machine from dust and strong air current. 

 Preventing the machine from direct sunlight or extremely bright lighting.  

 

Notice 3  Connecting the Power Supply 

Check the plug of the power cord to see if it mates with the wall outlet. If not, please contact 
your dealer. 

 Insert the plug (male) into a grounded power outlet. 

 Insert the other end (female) of power cord into the AC connector of cutting plotter. 

Notice 4  Tightening or Loosing Screws with Screwdriver 

Whether manual or electric screwdriver, be careful not to use excess torque force when 

tightening or loosing screws. When tightening or loosing iron and stainless steel screws, 

please refer to the following screw torque standard table, other materials screws are not 

included. 
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Screw 

diameter 

Torque value (kgf-cm) 

Torque standard for high hardness materials  

M3 6 

M4 16 

M5 30 

M6 50 
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2.2   Stand Installation  
(Stand is an optional item for 24 inch models.) 

 

2.2.1  Stand Installation 

Please follow the procedures below for assembling the stand. 

 

Step 1 Please examine the supplied items in the accessory box of the stand carton before 

you install:  

Stand is an optional item for Expert II, Item List： 

 1 Left side vertical stand 

 1 Right side vertical stand 

 1 Support for left side 

 1 Support for right side 

 1 Stand Beam 

  2 Bottom Stands with wheels 

  2 Sliding brackets for paper take up 

  1 Hex Wrench (M5)Φ4 

  28 Socket flat head screws(M6*12L) 

  1 Installation Guide 

 

 

Step 2 

Position the Left side vertical stand perpendicularly to part and put the screws into the 

holes and tighten them to form a left side T-stand (Figure 2-1). Repeat the same steps with 

the Right side vertical stand.  

 

 

Left side vertical stand 

 Bottom Stand 

Figure 2-1 
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Step 3 

Place the stand beam upright on the T-stand and put the screws into the holes but do not 

tighten them at this step. There is hexagon socket head screws fasten on the T-stand on 

both side taken as locating pins. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Step 4 

Remove the cutting plotter from the carton. Position the stand under the plotter, on the 

bottom of the plotter, there is one hole on each side in the position corresponding to the 

locating pins, so the locating pins can be located into the holes. Then insert the screws into 

the holes on the stand to lock the plotter and tighten them up as shown in Figure 2-3.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

T-stand 

Stand Beam 

Figure re 2-2 

Figure 2-3 

Screws 
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Step 5 

Insert the roll holder support with the screws into the holes of the stand, and then tighten 

them up as shown in Figure 2-4. You could decide roll holder support’s position by inserting 

into different holes. 

 
 
Step 6 

Place two roll holders onto the roll holder support and ensure the white protrusion is wedged 

in the groove. (Figure 2-5)  

 

Roll holder support  

3 screws 

Figure 2-4 

Roll holder support 

Roll holder 1 

Figure 2-5 

Roll holder 2 
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Step 7 

Turn the screw counter-clockwisely for around three times after unpacking roll holder 2 

 
 

Step 8 

Insert the end of the roll holder without the damper into the left roll holder support and then 

insert the end of the roll holder with the damper into the right roll holder support. Ensure the 

white protrusion is wedged in the groove. 
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Step 9 

Tighten the screw on the damper until it is securely attached to the right roll holder support. 

 

 

Step 10 

Lastly, the complete picture will be shown like below. (Figure 2-6) 

 

 
 

Figure 2-6 
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2.3    USB Cable Tie and Saddle 
 
The USB cable tie and saddle assembly for the stands with Flexible Media Support System only. 

 
Step 1 Insert the cable tie into the upper hole of cable saddle from bottom to top. 

        This side up 

 

Step 2 Place the USB cable into the cable tie and tighten the cable tie. 

  

 

Step 3 Insert the cable tie end into the lower hole of cable saddle to finish the job. 

  
Untied way: pull out the cable tie pull up the pin release the cable tie. 
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 Pull out the cable tie 

 Pull up the pin 

 Release the cable tie 
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Figure 2-7 

 Pin 

Outward ring 

Adjustment depth knob 

2.4 Blade Installation 
  
Figure 2-7 is the illustrator of the blade  

holder. Insert a blade into the bottom of  

the blade holder and remove the blade by 

pushing the pin. Make sure that your fingers  

are away from the blade tip.  

 

 

 

 

 

Step 1                                   Step 2 

Install blade (Figure 2-8).                   Push the blade to the bottom of the blade  

 holder (Figure 2-9).  

 

 

 

 

 

 

 

 

 

 

Step 3 

Adjust the blade tip to suitable length by  

screwing “Blade tip adjustment screw”  

clockwise or count-clockwise. (Figure 2-10).  

 

 

 

 

 

 

 

 

 

 

 

Tips: 

“The proper length” means the blade’s 

length is adjusted 0.1mm more than film’s 

thickness. That is, if the thickness of film is 

0.5mm, then blade’s length is properly 

adjusted 0.6mm and it can completely cut 

through the film layer yet avoid penetrating 

the backing. 

Figure 2-9 

Figure 2-10 

Figure 2-8 
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Caution!! 

The blade will lose its sharpness after a period of usage, the cutting quality 

might be affected. By increasing the cutting force, it might do the trick. 

However, once the blade is worn out and no longer provides a reliable cutting, 

you should replace a new one. The blade is consumable and must be 

replaced as often as necessary to maintain the cutting quality. The quality of 

the blade deeply affects cutting quality. So be sure to use a high quality blade 

to ensure good cutting results. 

 

Tips - When to replace a new blade: 

 If the blade is broken, you have to replace a new one. 

 If cutting quality is not as good as usual, you may need to replace a new one. 

 If the material cannot be cut through by higher cutting force, you may need 

to replace a new one.  

Step 4 

Insert the blade holder into tool carriage. Please note the outward ring of the holder must put 

into the grooves of carriage firmly (see Figure 2-11), fasten the case (Figure 2-12).  

                     

 

 

 

 

 

 

 

 

Figure 2-11                             Figure 2-12   

 

Step 5 

Use the reversing steps to remove the blade holder. 

 

 

Step 6 

Eject the blade: Push “Blade eject pin” to eject blade when the blade needs to be 

replaced.   
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Figure 2-13 

Figure 2-15 
Figure 2-16 

Figure 2-14 

2.5 Media Loading 
 

2.5.1 Loading the Sheet Media 

To load the media properly, please follow the 

procedures below: 

 

Step 1 

Lift the 2 levers at the back side of the cutter to lift the 

pinch rollers (Figure 2-13). 

 

 

Step 2 

Load your media on the platen and slide it under 

the pinch rollers from either the front side or the 

backside. The alignment rulers on the platen 

extension will help you to adjust the media 

precisely (Figure 2-14). 

   

 

Step 3 

Then move the pinch rollers manually to the proper position. Be sure the pinch rollers must 

be positioned above the grid drum. The stickers on the main beam show the position of the 

grid drums (Figure 2-15).   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Stickers 
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CAUTION!!! 

 Make sure the Primary and secondary pinch rollers are set to right positions. 

 Position the Primary Pinch Rollers at the right and left sides of media. 

 Position the Secondary Pinch Roller at the center of media.    

Note: Expert II serves as an illustrator here.   

 

 

 

 

 

 

Primary Pinch Roller 

Figure 2-17 

(X) 

Incorrect 

(O) 

Correct 

Secondary Pinch Roller 

Figure 2-18 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4 

Push the lever backward to lower down the pinch rollers (Figure 2-16). 

 

Step 5 

After turn on the power, the tool carriage will measure the size of the media automatically. 

And the plotting cutter begins to work. 
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Figure 2-19                       Figure 2-20 

(O)       (X) 

Correct                Incorrect    

 

2.5.2 Loading the Roll Media  

 

You can use the stand. Please refer to Chapter 2.2 for hardware setup, and Chapter 2.5.1 

for media loading. 

 

 

2.5.3 How to change the poll size without turning off the machine? 

 

Have the machine on-line, press origin set once and the red error light will start blinking, 

then pressed again and the machine will start moving to get the new size. Then open the 

VLCD and under the poll size you will find the new measurements. 

 

 

 

 

 

 

 

Note: 

 Always adjust the position with the pinch rollers raised. 

 Please reposition the pinch roller by holding the center of the pinch roller and 

moving it from the rear end of the machine. (Figure 2-19) 

 DO NOT move the pinch roller by holding its front rubber roller (Figure 2-20).   



                                                       Expert II User Manual 

Installation                                       2-15

2.5  Cable Connection  
 

The cutting plotter communicates with a computer through a USB (Universal Serial Bus) 

or a Serial port (RS-232C). This chapter shows you how to connect the cutting plotter to a 

host computer and how to set up the computer and cutting plotter interconnection. 

 

 NOTICE: When USB connection is enabled, serial port will be disabled automatically.  

 

 
2.5.1 USB Interface 

Expert II series build-in USB interface are based on the Universal Serial Bus Specifications 

Revision 2.0 (Full Speed). 

 

2.5.1.1 Connecting your GCC cutter 

1. Turn on the machine. 

2. Connect the USB connector to the machine and then USB driver will installed 

automatically. It will take a few minutes to find the device. Please DO NOT disconnect 

the USB cable until the installation has completed.  

3. You can double click the USB icon on the taskbar to make sure the USB device is 

detected. 

 
 

2.5.1.2 Installing the driver 

Use the USB One-click Installation for quick driver installation. Follow the simple steps 

below for driver setup. 

 

 

 

 

 

Step 1 Visit GCC website and go to “SUPPORT” page to download the user manual, driver 

and software (https://www.gccworldnew.com/download.php).  

 

Caution!! 

 If you are using Windows 7 and above as your operating system, 

make sure you log in using the “Administrator” account. 
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Step 2 You may use search function or directly click the product category to choose the 

model you want. 
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Step 3 Unzip the file and double clip the driver.exe to start installing the Driver and AAS 

plug-in.  

 
 

Step 4 If you were Windows 7 and above users, please click on the red words to instruct 

you how to disable Windows Update to allow success driver installation. And then click OK 

to next step. 

 

 

Step 5 Please make sure the cutting plotter is powered on and connected to the USB device, 

and then click OK to next step. 
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Step 6 Confirm to close all running application programs before you start installing the driver, 

and then click OK. 

 
 

Step 7 The installation will take a few minutes to complete and you will see a message 

below and click on “OK” upon completion. Enjoy your GCC cutter! 

 

 

Step 8 If you want to install AASII VBA on CorelDRAW and Adobe Illusatrator, exit 

CorelDRAW and Adobe Illusatrator program, and then click on“Install.” 

 

 

Step 9 Check Install Message to confirm CorelDRAW and AI version and then click OK. 
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Note: 

(1) If the driver is being installed for a second time, the user will be prompted as to 

whether a second copy of the driver installation is required. 

 

(2) If the user selects yes, a second copy of the driver will be installed. 

   
(3) For users who have upgraded Adobe Illustrator or CorelDRAW, please go to the 

AAS Installer page in the Printer Properties window and click “Install” to access 

the latest version of GCC AAS Plug-in. 
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2.5.1.3 Driver Un-installation 

 

You have to remove previous version driver installed on your PC system completely 

before you can install the latest version successfully. Please refer to below steps.  

 

 

Step 1 Go to Control Panel\Hardware and Sound\Devices and Printers window. Right 

click the printer and select “Remove device.” 
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Step 2 After removing the unit, click on any printer on the page and select “Print server 

properties.” (For Win 7 and above) 

Or right click on blank space and then select “Print server properties.” (For 

Windows XP) 

 

 

 

Step 3 Select “Driver” page 
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Step 4 Select the model and click on “Remove”. 

 

 

Step 5 Select “Remove driver and driver package” and click OK. 

  
 

Step 6 Click Yes and then click “Delete” and “OK,” and the driver installed on PC is 

completely removed. 
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2.5.2 RS-232 Interface 

 Connecting to the RS-232 (Serial) Port  

1. For IBM PC, PS/2 users or compatibles, connect the RS-232C cable to the serial 

connector of the assigned serial port (COM1 or COM2) of your host computer.  

2. Set up the communication parameters (Baud Rate and Data Bits/Parity) to match the 

setting of software package, refer to chapter 3 – “Misc” key description.  

 

 

 

2.5.3 Data Transmitting  

There are two options to transmit the data from the computer to the cutting plotter:  

 

Option 1: With proper interface settings, the data can be transmitted from your application 

software package to the cutting plotters directly.  

 

Option 2: Most cutting software packages are able to emulate HP-GL or HP-GL/2 

commands. As long as the file is HP-GL or HP-GL/2 format, the cutting plotter 

can output the data precisely. 

 

 

 

 

 

 

 

Caution!! Please turn off the plotter before plugging the RS-232C 
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2.5.4 Printer Sever Shared Setting 

In “A-PC”, set the printer driver as a shared printer, then use B-PC to connect A-PC’s printer 

driver via Intranet. 

A-PC            B-PC 
 
 
 
 
 
 

 

 

 

 

 

 

Step 1 Set A-PC’s printer driver as a shared printer (Right-click on printer icon, choose 

“Printer properties”. Click “Sharing” tab then check “Share this printer.”) 

  
 

 

 

 

 

 

 

 

Intranet 

USB or COM 
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Step 2 Click “Advanced” tab, then choose “Print directly to the printer” option. 

 
 

 

 

 

Step 3 Send a job from A-PC to the machine to check if A-PC is connected to the machine. 

 

 

 
 
 
 
 
 
 
 

 

 

 

 

 

 

Try to send a job 

to check if the 

port is working. 
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Step 4 Activate A-PC’s Printer Driver from B-PC’s Network. 

 

 

Step 5 Right-click on the printer icon, and select “Connect” to A-PC’s printer. 

 

 

 

2.6 Software Installation 

 

2.6.1  GreatCut Installation 

 

Step 1 Visit GreatCut online registration page http://gccvoucher.eurosystems.lu/, enter your 

voucher code provided when purchasing GreatCut and click “Go on!” 
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Step 2 Click “Request” to go to registration page.  

 

 

Step 3 Fill in the required information and click “Request license code.” 

 

 

Step 4 The registration is completed; you should receive two emails, one is registration 

confirmation with activation link and another is your license data with .ecf file. 

 

 

 



                                                       Expert II User Manual 

Installation                                       2-28

 

 

Step 5 Check your email to see if you receive the activation link and click the link that will 

direct you the link for GreatCut download. 

 

 

Step 6 Visit GCC website and go to “SUPPORT” page to download the user manual, driver 

and software (https://www.gccworldnew.com/download.php).  
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Step 7 Select a destination folder. 

 
 

 

 

Step 8 Select Typical and click Next. 

Note: You may select custom setup to install additional drivers. 
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Step 9 Select the folder and click Next. 

Default program folder in the start menu is GCC\GreatCut 4. 

 

 

Step 10 GreatCut is installing. 

 

 

Step 11 Click Finish to complete installation. 

 



                                                       Expert II User Manual 

Installation                                       2-32

 

Step 12 Before you launch GreatCut, open the .ecf attached to the license data email to 

install your license data to GreatCut so that you don’t need to fill in your 

information again. 

 

 

 

Step 13 If the license do not install successfully, you will need to fill in your license data 

manually. You can find the details of your license data from the email. 
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Step 14 GreatCut is ready to use now. 

  

 

2.6.2  Sure Cuts A Lot Installation (Optional Item) 

2.6.2.1  Auto Installation  

Step 1 Visit GCC website and go to “SUPPORT” page to download the software 

(https://www.gccworldnew.com/download.php). The software is compatible with 

Windows 7 and above and Macintosh OSX 10.6 and above.  
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Step 2 Download “Sure Cuts A Lot” to start the installation.  

 

Step 3 Press Next to continue.  

 

 

Step 4 Select “I accept the agreement” and press “Next.”  
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Step 5 Use the default folder (suggested) or select a folder you want to install the Sure Cuts 

A Lot and press “Next.” 

 

 

Step 6 Tick “Create a desktop icon” if you want to create a shortcut on your desktop, and 

tick “Associated scut4 extension” to associate the scut4 extension file with Sure 

Cuts A Lot software. Then press “Next” to start the installation.  

  

  
 

Step 7 Don’t tick “Install USB Driver” and tick “Launch Sure Cuts A Lot,” and then press 

“Finish” to compete installation. 
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Step 8 Run Sure Cuts A Lot. 

 

 

Step 9 Press “Activate…”to activate Sure Cuts A Lot. Please make sure it is connected to 

the internet.  

  
 

Step 10 Put your name in the Name column and enter the 25-letter software key to the 

Serial column and press “OK” to complete the activation. 
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Step 11 Launch Sure Cuts A Lot, select “My Cutter” under “Cutter” and select “Manage 

Cutters.” 

 

 

Step 12 Select Company/ Brand as “GCC” and the model you want to output, and then click 

the “Add to list” button and “Done.” 

 

 

 

 

 

Note 

 If you use a trial version to 

output graphics, meaning 

you do not enter the 

software key to activate 

the Sure Cuts A Lot 

mentioned above, there 

will be two extra lines cut 

through the design, 

therefore, make sure the 

Sure Cuts A Lot software 

is activated before 

implementing cutting jobs. 
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2.6.2.2 Manually Activate Software 

If the computer connected to cutter doesn’t have internet connection to accomplish above 

software activation process, you can use “Activate manually” function alternatively to enter 

the “Activation Code” to start the usage of Sure Cuts A Lot. Meanwhile, you need to find 

another computer that has internet access to obtain the “Activation Code” in advance 

following below instructions.  

 

Step 1 Check the "Activate manually" checkbox and you should see the Site Code and 

Activation Code fields appear. The Site Code field will be pre-filled in and cannot be 

changed. 

 

 

Step 2 Visit http://www.craftedge.com/activation/surecutsalot via an internet connected 

computer. Enter your name, serial (software key shows on the voucher code card) 

and site code. 
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Step 3 Click on the "Generate Activation Code" button, and your activation code will be 

shown in the Activation Code field. 

 

 

Step 4 Copy and paste the activation code back into the activation dialog box of Sure Cuts A 

Lot program and hit ok.  

 

2.6.2.3 Re-install Sure Cuts A Lot Software 

If you change a new computer, you may need to deactivate your Sure Cuts A Lot software 

and re-install it on your new device.  

 

Go to “Deactivate…” under Help and press Yes to confirm, then follow the installation 

procedure and use the same code to activate it on another computer. 
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Chapter 3  Operation 

 
3.1 The Control Panel 
  
3.1.1 The Outline of control panel 

 

 

 

 

 

 

 

 

Key Function 

POWER LED To indicate the power status ( light up: power on; light off: power off ) 

ERROR LED To indicate the error status ( light up: error; light off: normal ) 

ON/OFF LINE 

To switch modes or stop cutting job( light up: on-line; light off: off-line ) 

While in on-line mode: only ON/OFF LINE and PAUSE keys activated 

While in off-line mode: the settings in VLCD can be adjusted.  

PAUSE To temporarily halt cutting process or to continue 

REPEAT To repeat last job. 

DATA CLEAR  To clear up buffer memory. 

CUT TEST To perform cutting tests on different media. 

ORIGIN SET  To reset origin at a new position.  

4 Arrow Keys To move carriage position, select function, or change setting. 

 

3.1.2 Reset Origin 

 

 

 

 

 

Figure 3-1 

Note: 

 Make sure the machine is in off-line mode to enable this function.  
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Step 1 Move the carriage to a new position. 

 

Step 2 Press the ORIGIN SET button to reset origin.  

3.1.3 Cut Test 

  

 

 

 

 

 

Step 1 After sizing, press the ON/OFF LINE button to set as off-line mode. 

 

Step 2 Move the carriage to a preferred position. 

 

Step 3 Press CUT TEST button to perform. 

 

3.1.4 Repeat  

 

 

 

 

Step 1 Press the ON/OFF LINE button to set as off-line mode. 

 

Step 2 Press the REPEAT button to perform re-plot function starting at the position where  

        the carriage locates. It is also available to move carriage to a preferred position,   

re-set origin, and then perform this function.    

 

3.1.5 Repeat AAS Job 

This feature allows users to repeat AAS jobs automatically without having to operate on the 

computer side. 

 

Step 1 When the first AAS job finishes, press “Repeat” on the control panel to activate this 

function. 

 

 

 

 

 

Note: 

 Make sure the machine is in off-line mode to enable this function.  

 It’s recommended to keep performing this function until the cutting 

quality meets your demand before executing the cutting job. 

Note: 

 Make sure the machine is in off-line mode to enable this function.  

Note: 

 Please be noted that this feature is mainly applied to the Single paper 

mode; ensure a new piece of material is loaded and the origin 

repositioned to the first registration mark before “Repeat” is pressed. 
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Figure 3-3 Figure 3-2 

3.2 VLCD 
    “VLCD” is a computer program to help modify parameters of cutting functions. 

  
3.2.1 Installation 

Step 1 Download the VLCD.exe file from download area on GCC website onto your local 

drive to finish installation (Download Area → Vinyl Cutter → Expert II → Software, 

https://www.gccworld.com/download.php?act=view&id=21).   

 

Step 2 Launch VLCD by double-click on the icon.  

 

 

 

 

 

Step 3 Choose the right port connected to your computer (Figure 3-2).  

If you are using the USB cable, choose the model name from the pull down menu. 

If you are using a Serial cable, choose either COM1 or COM2. Make sure no other 

devices are occupying the port that you are going to use. 

 

Step 4 Press the Connect button to connect your computer and the cutter. If the 

connection succeeds, the model info, firmware version, and adjustable parameter 

columns will be showing (Figure 3-3). 

   

 

 

 

Note: 

 Make sure the machine is in on-line mode to enable this program.  

 There is media in the machine. 
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Figure 3-4 

 

3.2.2 Functions of VLCD 

 

Below are the functions adjustable in VLCD for Expert II.  

 Poll Size 

 Blade Force 

 Blade Holder 

 Media Weight 

 Blade Offset 

 AAS Offset 

 Auto Unroll 

 Update 

 

 

 

 Poll Size 
To reveal the X/Y values.  

 

In the case, the maximum plotting length 

is 25000mm, and the distance between 

the farthest two pinch rollers is 158.975 

mm (Figure 3-4). 

 

 

 

 

 

 

 

 

 

 

 

 Blade Force 
To adjust the blade force between 0 and 350 (Default = 35).  

 

Note: when plotting with a pen, adjust the Force to the lowest setting to avoid faint lines as 

well as to extend the life of a pen. 
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 Blade Holder 
To choose the blade holder- Plastic (Default) or Metal. 

 

 Media Weight 
To choose different weights of media in two options: Heavy, and Light (Default).  

 
 Blade Offset 

To adjust the blade offset to ensure cutting quality in 8 options: 0.000, 0.175, 0.250 

(Default), 0.275, 0.300, 0.500, 0.750, and 1.000.  

 

 AAS Offset 
 
To set or modify AAS offset value. 
You can refer to “5.3 Printer Test” for more details. 

 

 

 Auto Unroll 
To switch options for sheet media and roll media (Auto Unroll On: Default). 

 

 Update 
To apply the changed setting onto the cutter by presses the Update button. 
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3.2.3 Restore factory default settings 

VLCD allows you to turn all parameters to factory-default settings. 

 

Step 1 Enter the USB-port switching mode by pressing “Pause”(2) after “On/Off line”(1) and 

then press “Origin Set” (3). 

 

 

Step 2 Press the left key (4) and then up (5) 

 

 

Step 3 You have now entered the Data clear and restoring default settings mode; press “Data 

clear” (6) and then “Origin Set” (7) to confirm.  

 

 

Step 4 The default settings restoring process has been completed. All buttons will be ineffective 

before the cutter is rebooted. 

 



                                                                    Expert II User Manual 
 

Operation 3-7

Step 5 Restart your cutting plotter now. 

3.3 File Uploader 
 

3.3.1 Installation 

 “File Uploader” is a tool to help loading files for direct output. 

 The program ONLY supports HPGL format-files generated via GCC Cutter driver. 

 Download the GCC File Uploader.exe file from GCC website onto your local 

drive to finish installation (Download Area → Vinyl Cutter → Expert II → Software, 

https://www.gccworld.com/download.php?act=view&id=21)  

 Launch GCC File Uploader by double-click on the icon (Figure 3-5). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.3.2 Functions of File Uploader 

 

 Port setup 
 This function will be activated while choosing COM port for data transmission. 

 Press the Port setup button to pop up the setup window for parameter change (Figure  

3-6).  

 

 Repeat 
 Activate this function by click on the Repeat’s checkbox. 

 Repeat Delay – the pause time between jobs; Unit: second. 

 Repeat Counts – the number of repeat jobs.  

 

Figure 3-5 Figure 3-6 
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3.4 Data Transmission 
 
There are two options to transmit the data from the computer to the cutting plotter:   

Option 1: With proper interface settings, the data can be transmitted from your application 

software package to the cutting plotters directly. 

 

Option 2: Most cutting software packages are able to emulate HPGL or HPGL/2 commands, 

therefore. As long as the file is HPGL or HPGL/2 format, the cutting plotter can 

output the data precisely. 

 

3.5 Expert II Print Driver Setting 
3.5.1 Expert II Print Driver setting>Option Page 

 

File Function: 

The file function section allows users to set the parameters of Speed, Force, Offset and Quality 

for later use. This section is useful when performing repeated jobs on a variety of objects, 

allowing you to save your frequently used cutter parameters and load them in the future. 

 

• Custom Media: This section lists the files for the parameter settings that you have recently 

created and worked. You can save more than 50 files to simplify your cutting job. 

 

• Default: This section contains the reference settings that are applicable with the verified 

materials to achieve the best cutting results. Please note that the setting value might need to 

be adjusted according to different suppliers of materials. 

 

• SAVE: This function will save current print driver parameter settings to a file under the 

specified location on your computer. (Saved parameter setting files will be tagged with the 

Expert II series extension)  

 

• LOAD: This function allows you to load previously saved print driver parameters. 

 

• ORIGINAL: This function will load the print driver’s original factory parameter settings. 

 

• SAVE TO DEFAULT: This function allows you to save your current print driver parameters as 

the default startup settings. 
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• DELETE: This function will delete the file you select from the Custom Media section, whereas 

the settings in Default section cannot be deleted. Please note the delete function only 

removes the list shown in Custom Media section, it does not remove the file from your hard 

drive, if you wish to completely remove the file from your hard disk, you will have to manually 

delete the file from your operating system. 

 

Die Cut 

The Die Cut function must be activated with the Kiss Cut function to avoid the falling of 

cut-through materials and material jam beneath the carriage. Die Cut helps you to cut through 

the backing of the material while Kiss Cut cuts through only the top layer but not the backing. 

This will leave only tiny bits of the backing attached to the top layer, creating complete individual 

patterns with backing sheets (see figure 3-7 and 3-8).  

 

Figure 3-7 

 

 

Figure 3-8 

 

 

 

 

Cutting line 

Vinyl 
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To activate the Die Cut function, go to “Option”, tick “Die Cut”, and enter the amount you wish 

for the “Length” and “Force” of both Die Cut and Kiss Cut, then click “OK” (see figure 3-9).  

     

When the job is completed and you untick the Die Cut function, you will be able to adjust the 

pen speed, pen force, and offset in the section on the top following normal operating 

procedures (see figure 3-10). 

  

 

 

 

 

  

Note:  

1. The extension of the blade has to be set to 

cut through both the top layer and the backing 

in the very beginning. You then adjust the tool 

force for the best cutting performance.  

2. Once the Die Cut function is activated, it 

will perform on all the line segments on the 

object.  

  

*Note:  

The length setting for the 

cutting line of Die Cut is in the 

range of 0-2000mm whereas 

that of Kiss Cut is 0-100mm. 

Figure 3.9 
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Figure 3-10 

 

3.6 Reference Parameter Setting for Different Materials  
The following reference parameter is used on GCC verified materials shown in the table.  

Material  
Personalized/ Wall 

stickers 
Vehicle stickers Window decoration Window tint 

Blade red red red red / yellow 

Blade tip length (mm) 0.28 0.27 0.25 0.09 

Force (g) 105 85 95 70 

Speed (cm/sec) 72 60 65 72 

Offset (mm) 0.25 0.25 0.25 0.25 

Recommend model 
RX, Jaguar, Puma,  

EX, AR 

RX, Jaguar, Puma,  

EX, AR 

RX, Jaguar, Puma,  

EX, AR 

RX, Jaguar, Puma,  

EX, AR 

Material  Stencil Reflective film Flock Cardboard 

Blade red / green green green green 

Blade tip length (mm) 0.3 0.5 0.3 0.3 

Force (g) 180 380 135 165 

Speed (cm/sec) 15 3 30 30 

Offset (mm) 0.25 / 0.5 0.5 0.5 0.5 

Recommend model 
RX, Jaguar, Puma, 

EX, AR 

RX, Jaguar, Puma,  

EX 

RX, Jaguar, Puma, 

EX, AR 

RX, Jaguar, Puma, 

EX, AR 

Material  Magnets Protective tint Rhinestone Sandblast mask 

Blade green green green blue 

Blade tip length (mm) 0.8 0.3 0.8 0.27 

Force (g) 580 320 190 85 

Speed (cm/sec) 3 3 15 60 

Offset (mm) 0.5 0.5 0.5 0.25 

Recommend model RX, Jaguar 
RX, Jaguar, Puma,  

EX 
RX, Jaguar, Puma 

RX, Jaguar, Puma, 

EX, AR 

Material  Small text (vinyl) 

Blade black 

Blade tip length (mm) 0.27 

Force (g) 
thick: 150  

thin: 90 

Speed (cm/sec) 9 

Offset (mm) 0.175 

Recommend model RX, Jaguar, Puma 
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Chapter 4  Basic Maintenance 

 

This chapter explains the basic maintenance (i.e. cleaning the cutting plotter) required 

for the cutting plotter. Except II for the steps mentioned below, all the other 

maintenances must be performed by a qualified service technician. 

 

 

4.1 Cleaning the cutting plotter  
 

In order to keep the cutting plotter under good conditions and have the best performance, you need to 

clean the machine properly and regularly.  

 

Precaution in Cleaning 

 

 

 

 

 

 

 

Recommended Methods 

 

 Gently wipe the cutting plotter surface with a lint-free cloth. If necessary, clean it with a water-rinsed 

or an alcohol-rinsed cloth. Wipe the cutting plotter to remove any residues on the cutting plotter. 

Finally absorb water with a soft, lint-free cloth. 

 Wipe all the dust and dirt from the tool carriage rail. 

 Use a vacuum cleaner to clean any accumulated dirt and media residue beneath the pinch roller 

housing. 

 Clean the platen, paper sensors and the pinch rollers with a water-rinsed cloth or alcohol-rinsed 

cloth. Finally absorb water with a soft, lint-free cloth. 

 Use the same method mentioned above to clean dust and dirt from the stand. 

 

 

 

 

 

 

 Unplug the cutting plotter before cleaning.  

 Never use solvents, abrasive cleaners or strong detergents for 

cleaning. They may damage the surface of the cutting plotter and 

the moving parts.  
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4.2 Cleaning the Grid Drum  
 
 Turn off the cutting plotter, and move the tool carriage away from the area needed to be cleaned. 

 Raise the pinch rollers and move them away from the grid drum for cleaning. 

 Use a bristle (a toothbrush is also acceptable) to remove dust from the drum surface. It needs to 

rotate the drum manually to clean the drum completely (Figure 4-1). 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.3 Cleaning the Pinch Rollers  
 

If the pinch rollers need a thorough cleaning, use a lint-free cloth or cotton swab to wipe away the 

accumulated dust from the rubber portion of the pinch rollers. To prevent the pinch rollers from rotating 

while cleaning, use your fingers to hold the pinch rollers in place. 

 

Use a lint-free cloth or cotton swab rinsed with alcohol to remove the embedded or persistent dust. 

Figure 4-1 
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Chapter 5  Automatic-Aligning System 

 

AAS II (Automatic-Aligning System II) is only available for Expert II LX models. For Expert II 24 

or 52 users, you can skip this chapter. 

Please note that this chapter is only an instruction to AASII; for step-by-step instructions, please 

refer to the following chapters: 07_A-4 CorelDraw Plug-In, 07_A-5 Illustrator Plug-In, 07_A-6 

GreatCut Plug-In. 

 
5.1 Introduction 
 

The Expert II cutting plotters feature a standard Automatic-Aligning System (AAS II) to 

guarantee precise contour cutting quality by detecting the registration marks printed around the 

graphic. 

 

Notice  

 Avoid any kind of light source horizontally illuminating the AAS module.  

                                                                                                                                                                                    

                          

                                      

                        - PROHIBITED                        - ACCEPTABLE 

 

 DO NOT take off the cover of AAS module while in operation.  

    

                       - PROHIBITED 
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5.2 AAS Contour Cutting System 

 

The AAS system has one calibration procedures to ensure maximum accuracy of AAS 

operation. To operate the AAS you need to learn about the method of media feeding firstly. 

(Refer to 2.4 Media Loading.) 

 

5.2.1 Notice for Registration Marks 

The first registration mark is designed to be different in order to identify the origin for AAS 

auto-detection. The following precaution must be aware for registration marks to be read 

automatically. 

 Type of media 

 Registration mark pattern 

 Reading range required for detection the registration marks 

 Position for registration marks and medium 

          The registration marks have to be: 

 Created by cutting software like GreatCut or GCC CorelDRAW plug-in 

 In black color (printing quality of registration marks is essential; incorrect, 

misaligned colors, blurry or smeared printout might leading to inaccurate cutting 

result) 

 Length: The length of marks 

 Range: 5mm~50mm 

 Optimized Setting: 25mm 

 Thickness: The line thickness of marks 

 Range: 1mm~2mm 

     Optimized Setting: 1mm 

 Margin: The distance between marks and images 

 Range: 0mm~50mm 

 Optimized Setting: 5mm 

The cutter can not detect the marks while: 

 Cutter carriage is not located near the outside area of first mark before 

detecting (See the picture in page 5-7 for auto-detecting area of first mark.) 

 Medium thickness is more than 0.8mm 

 Transparent medium is used 

 Non-monochrome drawing. The marks can’t be read if is printed on colored 

medium 

 Dirty or creased medium surface 
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5.2.2 AAS II on Expert II  

There are three types of AAS II mark patterns: 4-Point Positioning, Segmental Positioning, and 

Multiple Copies. Note that before print out your designs by inkjet printers, the registration marks 

have to be created on your graphic designs by cutting software like SignPal, GreatCut or GCC 

CorelDraw plug-in. Hand-made marks or drawings won’t be reorganized by GCC cutting 

plotters. For more details about registration mark setting in cutting software, please refer to 

‘Appendix A-4 : CorelDraw Plug-In Instruction’, ‘Appendix A-5 : Illustrator Plug-In’, Appendix 

A-6 GreatCut Plug-In. 

 

1. 4-Point Positioning 

This is the basic mark pattern that AAS II will auto detect four registration marks and contour 

cut images inside those marks. 

 Command: Esc.D1;(XDist);(YDist): 

 Layout: 4 registration marks at the 4 corners around the design 

 
2. Segmental Positioning 

In addition to 4 original points, the intermediate registration marks are added on both X axis 

and Y axis to help contour cut accurately, especially for cutting large images. 

 Command: Esc.D2;(XDist);(YDist);(XStep);(YStep): 

 Layout:  

In-between distance on X: 200~600mm, default 300mm 

In-between distance on Y: 200-600mm, default 300mm            

 

 

3. Multiple Copies 

The function is used to duplicate images to let you cut quantities of images at a time.The 

AAS II sensor will automatically scan registration marks for each individual image to ensure 

the contour cutting precision.  
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 Command: Esc.D3;(XCopies);(YCopies);(Space): 

 Layout:  

                                     

 

5.3 Printer Test 
 

Before performing AAS contour cutting, it’s recommended to print out a test file to make 

sure the AAS II cutting accuracy. Please visit GCC website and go to Download Area to 

download the test files. 

https://www.gccworld.com/download.php?act=view&id=20   

 

. 
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There are two testing files for AASII: 

1.    AAS II_X_Y_Offset_Caberation_A4 .eps (A4 size) 

2.    AAS II_X_Y_Offset_Caberation_600_600 .eps (Default setting, it is recommended 

for testing) 

 Print out the testing graphic. ( Please use high precision printer) 

 Load the graphic to Expert II and sent the file to test the cutting job 

 If there are any adjustments to be made, you can change the offset value by 

following the steps: 

■ Measure the offset values from the printed line and the actual cutting line. 

■ Enter the AAS Offset under MISC function for the values you just measured, 

then press Enter 

■ Test the cutting again 

■  AAS II offset X and Y value is defined as following:       

Horizontal line is defined as X and vertical is defined as Y (when facing the 

cutting plotter) 

■  When the actual cutting line and the printed line need to be changed towards 

the direction of origin mark, then simply add the negative value of the offset. 

If the direction is from the opposite of the origin mark, then enter positive 

values for the offset (see the following figures). This method applies to both 

X and Y axes. 
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Note:  

 Before adjusting the AAS II settings, please proceed scaling for width and length. 

 The blade offset value isn’t set for this test graphic, please set it according to the 

blade you use. 

 If you have any question, please contact us or your local distributor for assistance. 

 

 

 

5.4 Registration Mark Offset Range  
Please correctly load your media (refer to the alignment ruler on the platen) to make sure the 

registration marks are successfully detected. Deviation exceeds the range below will lead to 

detection failure. 

 

 

5.5 Contour Cutting 
 

For accurate contour cutting with AAS function, please proceed the following steps: 

 

Step 1 Creating Graphics 

  ■ Create the graphic that you want to print and cut in your software. 

 

 

 

  ■ Create a contour for cutting around the graphic. 

 

 

 

TIPS1: Leave some space between the graphic and contour line. 

TIPS2: Create the contour in a separate layer and assign a different color for it. 

        ■ Add registration marks around the graphic. 
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    Note: 

The Multiple Copies function is also available. It automatically copy the graphic and 

registration marks. 

 

Step 2 Placing the Registration Marks 

 The AAS Layout Instruction: 

* Auto-detection function on the 1st mark covers the grey area 

 Suggested 30mm margin on both left and right sides of media sheet.  

 Suggested 20~30mm margin on top of media sheet, and at least 50mm margin on 

the bottom edge to prevent sheets dropping or any error occurred while media sizing. 
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Step 3 Print the Graphics  

  ■ Print the graphic and the marks with your printer  

(Scaling = 100%).   

  ■ When printing on a roll media, make sure the orientation as following: 

Step 4 Load the printout onto cutter 

  ■ The Origin Mark is different from the rest registration marks. Please make sure the 

media is fed with correct direction. 

              

Step 5 Cut the Contour 

  ■ Send out the command from software to perform the contour cutting job. 

 

 

5.6  Tips for AAS 
 

For getting better results of contour cutting, there are some tips below for your reference. 

 Keep light sources simple and avoid illuminating from the sides of cutter. 

 Before operating AAS, change the maximum paper size in Expert II driver 

property. 

Step 1 Find the Expert II model in the “Printer & Fax” folder of your PC. 

Step 2 Open the Properties window and select the “Paper” tab. 

Step 3 Change the maximum Paper Size of X to 1200mm. 

 Adjust the cutting speed to between 200~400mm/sec. 

 Avoid the registration marks locating on the tracks of pinch rollers. 

 Make sure the edge of the media is not bent up when detecting registration marks. 
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Chapter 6  Trouble Shooting 

 

This chapter helps you to correct some common problems you may come across. Prior to 

getting into the details of this chapter, please be sure that your application environment is 

compatible with the cutting plotter.  

 

Note: 

Before contacting your local dealer, please make sure that the problems are coming from your 

cutting plotter, not from the communication between the computer and cutting plotter or from a 

malfunction in your computer or software. 

 

 
 
 
 
 
 
6.1 What if Expert II cannot operate?  
 
If your cutting plotter doesn’t plot, please check the following items first: 

 

Solutions: If the POWER LED lights on, the cutting plotter should be in a normal condition.  

          Turn off the cutting plotter and turn it on again to see if the problem still exists. 
  If the POWER LED doesn’t light, please call your local dealer to resolve this 

problem. 
 
 

6.2 Light Indicators    
 
Some of the operating problems can be identified by the lights on the control panel.  

When your cutting plotter stops operating or the lights are on or flashing unexpectedly, see the 

following descriptions of the panel light patterns and the actions you should take. 

 

 

 Is the power cord plugged in properly? 

 Is the power cord connected to the power connector properly? 

 Is the power switch turned on properly?  

Why doesn’t the cutting plotter operate? 
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6.2.1 Warning Indicators 

 

When the ERROR LED flashes (as shown below), take the necessary actions according to 

the following instructions. When the problems are solved, the ERROR LED will turn off 

automatically. Pressing the ON/OFF LINE button can also turn off the ERROR LED. 

 

Warning Indicators ERROR 
ON/OFF 

LINE 
REPEAT 

DATA 

CLEAR 

CUT 

TEST 

1 Graph was clipped      
2 HPGL/2 command Error      
3 Lever up or no media      
4 Cannot repeat      
5 Communication error      
6 Width sensor error      

7 Check media, drum or X motor      

 = flash        = on         = off 

 

Warning 1 The graph is clipped   

This condition indicates that the cutting graph is bigger than the cutting area.  

 

You can solve the problem by:  

1. Reload a wider or longer media.  

2. Move the pinch rollers to widen the cutting area.  

3. Re-scale the graph to a smaller size. Then send the cutting job again from your computer 

to the cutting plotter. 

 

 

Warning 2 HPGL/2 command error   

If the cutting plotter cannot recognize the commands from your computer, please check the 

commands applied to your cutting plotter in the HP-GL/2 or HPGL commands. Then send the 

same job to the cutting plotter again. 

 

If that doesn’t solve the problem, please contact your local dealer. 

 

Warning 3 Lever up or no media    

Check that you have lowered the lever down and make sure that you load the media before 

cutting. 
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Warning 4 Cannot repeat cutting 

There are two possibilities:  

1. There is no data in the buffer: please send the job again from your computer;  

2. The buffer is full: please send the same job from your computer again.  

Under both conditions, press the ON/OFF LINE key to clear the warning message. 

 

Warning 5 Communication error 

Check that the serial/USB cable has been connected to the cutting plotter and computer 

properly.  

 

If so, then check whether the interface settings are correct. Check that the communication 

settings in your PC are the same as the ones on your cutting plotter (for example – 9600bps, 

no parity, 8 bits, 1 stop bit). Then, press ON/OFF Line key to switch back to On Line mode.  

 

Warning 6 Width sensor error 

Check that the pinch rollers are positioned above the grid drum and reload the media again.  

 

6.2.2 Error Indicators 

 

If some mechanical problems occur during the operation, the ERROR LED will turn on. Please 

follow the instructions below to solve the problem. If the cutting plotter still cannot work, 

please contact your local dealer and tell him or her about the error indicator. 

 

 Error Indicators ERROR 
ON/OFF 

LINE 
REPEAT 

DATA 

CLEAR 

CUT 

TEST 

1 SRAM error      
2 DRAM error      
3 Check media, drum, or X motor      
4 Check media or Y motor      

 = flash        = on         = off 

Error 1 and 2 

Please contact your local dealer to replace SRAM or DRAM. 

 

Note:  

In order to identify the warning messages easily, please stick the warning 

sticker (in accessory box) on the side cover of your cutting plotter. 
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Error 3 Check the media, drum or X-motor (Drum driven motor)     

This message indicates that there might be a problem on the X-axis.  

Please check that the drums are working normally and see that the media is well loaded. Then turn on 

the power and reboot the cutting plotter. 

 

Error 4 Check the media, or Y motor (carriage driven motor) 

This message indicates that there might be an obstruction to the carriage relating to a problem on the 

Y-axis.  

Please clear the obstruction and check that the carriage can move smoothly. Then turn on the power 

and reboot the cutting plotter. 
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6.3 Cutting Quality Problems  
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Is the blade installed correctly and the blade 

holder fastened securely? 

Yes No 

Is the blade dull 

or chipped? 

Yes No 

Replace 

with a new 

blade 

Is tool force set up 

properly? (The default 

for tool force is 80 gf) 

Yes No 

Adjust the tool force to obtain an 

optimum blade force. Refer to 

Chapter 4.3 “Cutting Force and 

Offset Adjustment” 

Is the tool offset set up 

properly? 

Yes No 

Adjust the tool offset to 

obtain an optimum value. 

Is there any dirt adhered to 

the blade? 

Yes No 

Refer to Chapter 2.3 

“ Blade Installation” 

Remove the 

blade and clean 

it. 

Please contact your dealer for 

technician support.  

Note: The daily maintenance of your cutting plotter is very important. 

Be sure to clean up the grid drum and pinch rollers regularly for better 

cutting accuracy and output quality. 
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Expert II Series Specification 

 

 Model Number EX II-24 EX II-24LX EX II-52 EX II-52LX  
 Max. Cutting Width 600 mm (23.6 in.) 1320 mm (51.96 in) 

 Max. Media Width 719 mm (28.3 in.) 1470 mm (57.87 in.) 

 Material Thickness 0.8 mm 

 Max. Cutting Force 350 g 

 Max. Cutting Speed 
705 mm/sec (27.8 ips) 

 (at 45 degree direction) 
635 mm/sec (25 ips)  

(at 45 degree direction) 
Mechanical Resolution 0.009 mm (0.00035 in.) 0.012 mm (o.ooo49 in.) 

 Software Resolution 0.025 mm (0.00098 in.) 
Distance Accuracy ±0.254 mm or ±0.1% of move, whichever is greater 

 Repeatability ±0.1mm 

Tracking 3M 

 Memory Buffer 1 MB / 500 KB (when using AAS) 

 Interfaces USB 2.0 (Full Speed) & RS-232            

 Type of Command HPGL, HPGL/2 

 Configurable Origin Yes 

 Control Panel 6 LEDs / 10 Keys 

 Diameter of Blade 2.5 mm 

 Dimension 
(H*W*D) mm 233*880*255 1065*1632*620 

(H*W*D) in 9.1*34.6*10 41.93*62.25*24.41 

 Net Weight 11KG (24.3lb) 53KG (116.4lb) 

 Stand Optional Standard 

Automatic-Aligning System 
(AAS II) 

Available on Expert II LX models 

Power Supply 100-240 VAC, 50 /60 Hz (auto switching) 

Power Consumption Max. 288 W 

Operation      
Environment 

Temperature 15°C~30°C / 60°F~86°F 

 Humidity 25% ~ 75% 
 

 Compatible with Windows 7 and above & MAC OS X 10.6 and above. (*Purchasing serial 

number for “Sure Cuts A Lot” software to work with Mac OS.) 

 The specification and data sheet may vary with different materials used. In order to obtain the 

best output quality, please maintain the machine regularly and properly. 

 GCC reserves the right to change the specifications at any time without notice 

 GCC certified material in tracking is Avery MPI 3000. 

 The above listed specification values are effective only when operated with media certified by 

GCC. 
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Blade Specification 

 

202003480G 

For cutting thick fluorescent and reflective vinyl. Also for cutting 
detailed work in standard vinyl. 

The blade is 45° with Red Cap (5-unit package), 0.25 mm offset, 
and 2.5 mm blade diameter. 

 

290088080G 

For cutting reflective vinyl, cardboard, sandblast, flock, and 
stencil sharp edge. 

The blade is 60° with Green Cap (2-unit package), 0.50 mm 
blade offset, and 2.5 mm blade diameter. 

 

265017550G 

For cutting thin sandblast mask and stencil. The blade with 
sharp angle and special design, allowing it to maneuver around 
sharp corners. 

The blade is 60° with Blue Cap, 0.25 mm blade offset, and 2.5 
mm blade diameter. 

 

265017560G 

For Cutting small text and fine detail. Sharp blade with smallest 
offset. 

The blade is 50° with Black Cap, 0.175 mm blade offset, and 
2.5 mm blade diameter. 

 

265017530G 

For thin and delicate media such as window tint. 

The blade is 25° with Yellow Cap, 0.25 mm blade offset, and 
2.5 mm blade diameter. 
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About the Tool 
 

A generic term referring to the blade that cuts the sheet, the pen that does plotting, 

and the LED bombsight (option) used for pointing to the reference point. 

OFFSET is the distance that the blade tip is displaced from the centerline of the 

blade. 
 

 

 

 

 

 

                                        

 

 

                   

                                                                  

 

                                                                  

 
 

Protrusion Length of the Blade 
 

 

 

 

 

 

 

 

 

 

 

 

Length of protrusion = t1 + t 2/ 2, but for your convenience you may just make it 

about 0.3mm ~ 0.5mm beyond the blade holder tip. 

 

 Central line   

Blade 

  Blade tip 

offset 

Thickness of the 

base paper (t 2) 

Thickness of  

the media (t1) 

Protrusion length 

of the blade 
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CorelDRAW Output Instruction                                                                                      

The following is an example of how to output the file with CorelDRAW.  

 

User Instructions 
 

1. Open CorelDRAW, finish editing all the files you wish to plot and select all the images 

at once.  

 

2. Select “Outline Pen” to adjust the outline for cutting.    

 
 

3. Adjust the value of pen width to 0.001 mm and click “OK” to save your input. 
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4. Select “ File → Print” to output the file to your cutters. 

 

 

 

5. Choose the correct model you have installed. 
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6. Choose the “Layout page” and click the “Reposition images to: → Bottom left corner”. 

Please note that you must put your image at the bottom left corner. 

 

    

7. Go back to the General page and check that your image is at the bottom left corner. Click 

“Print” and get a wonderful cutting image. 
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CorelDRAW Plug-In Instruction 

 
AASII VBA Installer is applicable for CorelDRAW Version 13, 14, 15, 16, 17, 18 

 

Installation 
Please refer to Step 8 in Chapter 2.7.1.2 Driver Installation to install AAS plug-in for 

CorelDRAW. 

 

Run CorelDRAW AAS Plug-in 
 

Step 1 Run CorelDRAW to edit your graphics and select all images at once when you wish to 

plot. 

 

Step 2 Select “ToolsMacrosRun Macro.” Then select Global Macros 

(GCCAASII_Draw13.gms) under the “Macros in” manual, and press “Run”.  
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Step 3 Click on “Apply” and select whether you would like to add the registration marks by page 

size or by object. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4 Now you can print out the image file with registration marks. 

 

 

 

 

 

 
 
 
You can also add a Hot Icon for the AAS Plug-in 
 

Select “Tools Options Workspace Customization Commands Macros 

GCCMadual.GCC_AAS_Plug_In” and Click OK.  

  

Note: “Add Registration Mark by Object” will be the default selection if you click on 

the image whereas “Add Registration Mark by page size” will be the default one 

when the blank area on the page is clicked. 
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Add Registration Mark by page size 
 

If you tick “Add Registration Mark by page size” as shown in the figure below and click “Apply”, 

your registration marks will be created automatically (please see Figure A3-1). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The system will create the 4 marks on the 4 corners of the page as shown in the picture below 

wherever you move your image. 

  

Figure A3-1 

Figure A3-2 

Figure A3-3 

Note: 

1.  The length setting will be in the range of 5-25mm 

according to your page size. 

 

2. Please DO NOT make any changes to the “Origin” 

section when you choose to add registration marks by 

page size as indicated below otherwise the position of 

the marks will be changed (please see Figure A3-2).  
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Workable area 

It allows users to edit and cut graphics in the area outside the registration marks when adding 

registration marks by page. 

 

For A4 size media sheet, the workable area is 2.5mm extended from the registration mark on 

left and right sides and 4.5mm extended from the registration mark on top side. On the bottom 

side, it is suggested to leave at least 25mm margin from the edge of media sheet to prevent 

sheets dropping or any error occurred while media sizing. 

 

For A3 size media sheet, the workable area is 10mm extended from the registration mark on the 

left side, 9mm extended from the registration mark on the right side and 11mm extended from 

the registration mark on top side. On the bottom side, it is suggested to leave at least 25mm 

margin from the edge of media sheet to prevent sheets dropping or any error occurred while 

media sizing. 

 
 

 

 

 

 

 

 

 

 

 

 

Note: Select “Edge” mode when media sizing to allow the media sheet to be unrolled. 

If you select “Single” mode, the media sheet will not be able to be moved back and 

hence fail to be detected by front paper sensor. 
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Add Registration Mark by Object 
 

If you tick “Add Registration Mark by Object”, you will be offered three options of registration 

marks as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

4-Point Positioning 

 Length: The length of marks 

 Range: 5mm~50mm 

 Optimized Setting: 25mm 

 Thickness: The line thickness of marks 

 Range: 1mm~2mm 

 Optimized Setting: 1mm 

 Margin: The distance between marks and images 

 Range: 0mm~50mm 

 Optimized Setting: 5mm 

 

Segmental Positioning 

 X Step: The distance of intermediate position on the X axis 

 Y Step: The distance of intermediate position on the Y axis 

 Range: 200mm~600mm 

 Optimized Setting: Less than 500mm 

 

Multiple Copies 

 No. of X Copies: The numbers of copies on X axis 

 No. of Y Copies: The numbers of copies on Y axis 

 Range: 1~50. (The more copies you make, the more time 

is needed for data transmission.) 

 Numbers of X Copies * Numbers of Y Copies = The total 

amount of image copies 

 Copies with outline：To show outlines of image graphics 

 

Figure A3-4 

Note: The values entered in the “4-Point Positioning” section (length, thickness and 

margin) will still be applied when you tick “Segmental Positioning” or “Multiple Copies”. 
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4-Point Positioning 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The system will create the 4 marks as shown in the picture below. 

 
 

 

 

 

 

4-Point Positioning 

 Length: The length of marks 

 Range: 5mm~50mm 

 Optimized Setting: 25mm 

 Thickness: The line thickness of marks 

 Range: 1mm~2mm 

 Optimized Setting: 1mm 

 Margin: The distance between marks and images 

 Range: 0mm~50mm 

 Optimized Setting: 5mm 

 

Figure A3-5 

Figure A3-6 
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Note:  

1. To save your materials, in addition to amending object margins, you can also adjust the 

length of the registration marks (5mm minimum) when you apply 4-Point Positioning (see 

table 1 for suggestions based on different material sizes). The smaller the size is, the 

smaller the distance between the object and the registration marks is (see the figures 

below).  

                  
 

 

 

 

 

 

 

 

 

Table 1 

*25mm is the suggested value for the registration mark length 

 

2. The size of the registration marks would affect the accuracy of registration mark detection so 

please make sure the amount you enter is reasonable.         

 

3. If you change the paper size, you will have to reset the registration marks otherwise the 

previous setting will be applied. 

 

 

 

 

Page size 

(unit: mm) 

Suggested mark length 

(unit: mm) 

A6 (105 x 148) 5 

A5 (148 × 210) 8 

A4 (210 × 297) 11 

A3 (297 × 420) 16 

A2 (420 × 594) 23 

A1 (594 × 841) and above 25* 

Area to be cut 

Figure A3-7 Figure A3-8 
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Segmental Positioning 

For precise cutting quality, it is suggested to select “Segmental 

Positioning” when you are working on an extra long or 

large-sized image to increase cutting accuracy. 

 

 

 

Segmental Positioning 

 X Step: The distance of intermediate position on the X axis 

 Y Step: The distance of intermediate position on the Y axis 

 Range: 200mm~600mm 

 Optimized Setting: Less than 500mm 

 

 

 

 

 

The system will create the as shown in the picture below 

 

 
 

 

Segmental Positioning will be applied to Multiple Copies when the object to be copied is of large 

size (with the length or width over 200mm) to increase the accuracy of registration mark 

detection. 

 

Figure A3-9 

Figure A3-10 

Segmental Positioning 
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Multiple Copies 

It is suggested to select “Multiple Copies” when you would like to make several copies of one 

image on your material to increase cutting accuracy.  

 

 

 

 

 

Multiple Copies 

 No. of X Copies: The numbers of copies on X axis 

 No. of Y Copies: The numbers of copies on Y axis 

 Range: 1~50. (The more copies you make, the more time is 

needed for data transmission.) 

 Numbers of X Copies * Numbers of Y Copies = The total 

amount of image copies 

 Copies with outline：To show outlines of image graphics 

 

 

 

The system will create the as shown in the picture below. 

 
 

 

 

 

 

X axis 

Y axis 

Figure A3-11 

Figure A3-12 
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Contour cutting through CorelDraw 

Step 1 Position the paper with registration marks printed by your printer on the GCC cutter. 

Step 2 Select “FilesPrint”. 

 

 

Note: if you use CorelDraw X5 and later, you must follow the steps below. 

 

Step 1 Click the “color” page and go to the “Color conversions performed by:” and then select 

the model name of you cutter (please refer to Figure A3-14). 

 

 

 

Figure A3-13 

Figure A3-14 
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Step 2 Go to the “Layout” page and select Bottom left corner at “Reposition images to”. 

 
 

Step 3 Click “Print”. 

Figure A3-15 
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Illustrator Plug-In Instruction 

 
AASII VBA Installer is applicable for Adobe Illustrator Version CS4, CS5, CS6, CC. 

 

Installation 
Please refer to Step 8 in Chapter 2.7.1.2 Driver Installation to install AAS plug-in for Adobe 

Illustrator. 

 
Printer Setting 

 

Step 1 Go to Control Panel, right click on the printer and select Printer Properties to open 

the Printer Properties page 
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Step 2 Go to the Advanced page and make sure the “Enable advanced printing features” 

box is unchecked. 
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User Instructions 
 
Step 1 Open Illustrator. 

 

Step 2 Edit your image and create a contour line (Note: you must have the line width set as 

0.001mm). 

  
 

Step 3 Click on the image and apply the AAS function (FileScripts_AASII_Plug_In). 

 
 

 

 

 

Contour line 
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Step 4 Select the registration marks needed 

 
 

Step 5 Three types of registration marks are introduced here: 4-Point Positioning, Segmental 

Positioning and Multiple Copies. 

  
 

 

Step 6 Confirm the registration marks (the 4-Point Position mark is used as an illustration in the 

following steps). 

Note:  

The values entered in the “4-Point Positioning” section (length, thickness and margin) 

will still be applied when you tick “Segmental Positioning” or “Multiple Copies.” 
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Step 6 Confirm the registration marks (the 4-Point Position mark is used as an illustration in the 

following steps). 

 

 

Step 7 Click on the blank area on the page and then click “Document Setup”. 
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Step 8 Hit “Edit Artboards”. 

 
 

Step 9 Click on “Presets → Fit Artboard to Artwork bounds”. 
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Step 10 Please move your mouse to the tool bar on the left when step 9 is finished and then 

click “Selection Tool”. 

  

 

Step 11 This will take you back to the edit mode. 
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Step 12 Print out the file with the contour line and the registration marks. 

 

 

Step 13 Place the printed file on the cutter, lower the pinch rollers and then position the carriage 

at the origin of the registration marks. 

 

Step 14 Send the file to the cutter. 
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Step 15 Select the cutter model, position the object in the bottom left corner.  

 
 

Step 16 Your job is now completed. 
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Add Registration Mark by page size 
If you want to create registration mark by page size, select the object, go to “Scripts” under 

“File” and select “_AASII_Plug_In” 

 

Tick “Make by page size” and click “Apply” and the 

registration mark will be created on the 4 corners of the 

page automatically, sown as below. 

 
 
 
 

Note:  

The length setting will be in the range of 10-50mm according to your page size. 
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Workable area 

It allows users to edit and cut graphics in the area outside the registration marks when adding 

registration marks by page. 

 

For A4 size media sheet, the workable area is 2.5mm extended from the registration mark on 

left and right sides and 4.5mm extended from the registration mark on top side. On the bottom 

side, it is suggested to leave at least 25mm margin from the edge of media sheet to prevent 

sheets dropping or any error occurred while media sizing. 

 

For A3 size media sheet, the workable area is 10mm extended from the registration mark on the 

left side, 9mm extended from the registration mark on the right side and 11mm extended from 

the registration mark on top side. On the bottom side, it is suggested to leave at least 25mm 

margin from the edge of media sheet to prevent sheets dropping or any error occurred while 

media sizing. 

 
 
 
 
 

Note: Select “Edge” mode when media sizing to allow the media sheet to be unrolled. If 

you select “Single” mode, the media sheet will not be able to be moved back and hence 

fail to be detected by front paper sensor. 
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Add Registration Mark by Object 
 

If you add registration mark by Object, you will be offered three options of registration marks. 

 

Firstly, select the graphic which you want to add registration mark on and go to “Scripts” under 

“File” and select “_AASII_Plug_In”. 

 
Make sure to untick “Make by page size” and choose one of the registration mark types 

whichever is suitable. 
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Three types of registration marks 
 

4-Point Positioning 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The system will create the 4 marks as shown in the picture below. 

 

4-Point Positioning 

 Length: The length of marks 

 Range: 5mm~50mm 

 Optimized Setting: 25mm 

 Thickness: The line thickness of marks 

 Range: 1mm~2mm 

 Optimized Setting: 1mm 

 Margin: The distance between marks and 

images 

 Range: 0mm~50mm 

 Optimized Setting: 5mm 
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Note:  

1. To save your materials, in addition to amending object margins, you can also adjust the 

length of the registration marks (5mm minimum) when you apply 4-Point Positioning (see 

table 1 for suggestions based on different material sizes). The smaller the size is, the 

smaller the distance between the object and the registration marks is (see the figures 

below).  

                  
 

 

 

 

 

 

 

 

 

Table 1 

*25mm is the suggested value for the registration mark length 

 

2. The size of the registration marks would affect the accuracy of registration mark detection so 

please make sure the amount you enter is reasonable.         

 

3. If you change the paper size, you will have to reset the registration marks otherwise the 

previous setting will be applied. 

 

 

 

 

Page size 

(unit: mm) 

Suggested mark length 

(unit: mm) 

A6 (105 x 148) 5 

A5 (148 × 210) 8 

A4 (210 × 297) 11 

A3 (297 × 420) 16 

A2 (420 × 594) 23 

A1 (594 × 841) and above 25* 

Area to be cut 
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Segmental Positioning 

For precise cutting quality, it is suggested to select “Segmental Positioning” when you are 

working on an extra long or large-sized image to increase cutting accuracy. 

 

 

 

Segmental Positioning 

 X Step: The distance of intermediate position on the X 

axis 

 Y Step: The distance of intermediate position on the Y 

axis 

 Range: 200mm~600mm 

 Optimized Setting: Less than 500mm 

 

 

 

 

 

 

 

 

The system will create the marks as shown in the picture below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Segmental Positioning 
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Multiple Copies 

It is suggested to select “Multiple Copies” when you would like to make several copies of one 

image on your material to increase cutting accuracy.  

 

 

 

 

 

Multiple Copies 

 No. of X Copies: The numbers of copies on X axis 

 No. of Y Copies: The numbers of copies on Y axis 

 Range: 1~50. (The more copies you make, the 

more time is needed for data transmission.) 

 Numbers of X Copies * Numbers of Y Copies = 

The total amount of image copies 

 Copies with outline：To show outlines of image 

graphics 

 Margin: Space between marks; must be 0 or ≧ 20, 

no negative numbers allowed 

 

 

The system will create the as shown in the picture below. 

 

 

X axis 

Y axis 
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GreatCut Plug-In Instruction 

 

The user manual of GreatCut software is available on GCC website download area. 

https://www.gccworld.com/download.php?act=view&id=20  
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GCC AASII System 

Below is a step-by-step instruction of using the AAS function in GreatCut software through 

CorelDRAW and Adobe Illustrator. 

 

 

Edit your image in CorelDRAW 
 

 

 

4-Point Positioning 

Step 1 Create a new file in CorelDRAW and click on the Create contour icon on the GreatCut 

toolbar (it would appear automatically once CorelDRAW is open). 
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Step 2 Complete contour line settings (including contour offset value) and press Calculate to 

confirm. 

  

 

Contour lines will be added to the images. 

 

 

 

Contour offset is the distance 

between the object and the 

contour line. 
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Tips: Vector object to create round outline 

 

In general for vector objects you will get better results with the outline function. You will 

see the difference between "Normal" and "Round" in sharp corners. The picture is shown 

as below: 

   

 

 

1. Click the “Create outline” to create contours in a freely definable distance around text 

objects. 

  

 

2. Select “Round corners” and set the value of “offset” and “tolerance.” 

Offset is the value for the distance of the inline and outline from the original object. 

The field tolerance indicates in which offset from the corner dot is cut respectively 

rounded. 

 

 

 

 

 

 

Normal Round 
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Step 3 Press the Settings icon on the GreatCut toolbar.  

  
 

Step 4 Press the button on the right of Jog marks. 
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Step 5 Adjust the size, object margin and line thickness of your registration marks in the 

Setup-Jog Marks window and click OK. 

  
 

Step 6 Ensure the three items below are selected and click OK. 

  
 

 

 

 

 

 

4-Point Positioning 

 Size: The length of marks 

 Range: 5mm~50mm 

 Optimized Setting: 25mm 

          Object margin: The distance  

between marks and images 

 Range: 0mm~50mm 

 Optimized Setting: 5mm 

  Line thickness: the line thickness 

of marks 

 Range: 1mm~2mm 

 Optimized Setting: 1mm 

 
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Step 7 Click the Set Jog Marks icon on the GreatCut toolbar. 

 
 

The system will create the 4 marks as shown in the picture below. 
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Note:  

1. To save your materials, in addition to amending object margins, you can also adjust the 

length of the registration marks (5mm minimum) when you apply the above function(see 

table 1 for suggestions based on different material sizes). The smaller the size is, the smaller 

the distance between the object and the registration marks is (see the figures below).  

                  
 

 

 

 

 

 

 

 

 

Table 1 

*25mm is the suggested value for the registration mark length 

 

2. The size of the registration marks would affect the accuracy of registration mark detection so 

please make sure the amount you enter is reasonable.         

 

 

 

 

 

 

 

 

Page size 

(unit: mm) 

Suggested mark length 

(unit: mm) 

A6 (105 x 148) 5 

A5 (148 × 210) 8 

A4 (210 × 297) 11 

A3 (297 × 420) 16 

A2 (420 × 594) 23 

A1 (594 × 841) and above 25* 

Area to be cut 
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Output 

Step 1 Select both the entire object (including registration marks and the contour line) and press 

the Cut icon on the GreatCut toolbar. 

 
 

Step 2 The system will activate GreatCut automatically and import the registration marks and 

contour line to GreatCut. 
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Step 3 Select Output under File. 

 

 

Step 4. Select Cut with AAS in Mode/Tool in the Output to device window. 

 

Complete the settings of AAS 

Offset, Pressure, Speed, 

Material width and so on. 
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Step 5 Click output and the object will be sent to GCC Cutting Plotter. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                          Expert II User Manual 

GreatCut Plug-In                               A-6 

Note: The difference amount Number of outputs, Number of copies, and Step count in the 

Output window. 

 

 
1. When Number of outputs is set as 2, the square and the triangle will be cut 1 time 

and then the square and the triangle will be cut 1 time at next position. 

 

2. When Number of copies is set as 2, the square and the triangle will be cut 2 times at 

the same position. 

 

3. When Step count is set as 2, the square will be cut 2 times at the same position and 

then the triangle will be cut will be cut 2 times at the same position. 
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Advanced Settings 
 

Segmental Positioning 

For precise cutting quality, it is suggested to apply “Segmental Positioning” by adjusting the x 

and y distance when you are working on an extra long or large-size image to increase cutting 

quality. 

 

Follow the same steps in the 4-Point Positioning section to complete the contour line setting 

and registration mark creation procedures. Adjust the size, object margin and line thickness of 

your registration marks and the space between registration marks by changing X, Y distance in 

the Setup-Jog Marks window and click OK. 

 

Step 1 Press the Settings icon on the GreatCut toolbar.  
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Step 2 Press the button on the right of Jog marks. 

  
 

Step 3 Adjust the size, object margin and line thickness of your registration marks in the 

Setup-Jog Marks window and click OK. 

  

  
 

 

 

 

 

Segmental Positioning 

 Max. x Distance: The distance of 

intermediate position on the X axis 

     Range: 200-500 mm 

 Max. y Distance: The distance of 

intermediate position on the Y axis 

     Range: 200-500 mm 
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Step 4 Ensure the three items below are selected and click OK. 

  
 

Step 5 Click the Set Jog Marks icon on the GreatCut toolbar. 

 
 

 

 

 
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The system will create the marks as shown in the picture below. 

 
 

Follow the same steps in the Output section to output your image to GCC Cutting Plotter. 

 

 

Multi-Copy 

 

Step 1 Follow the same steps in the 4-Point Positioning section to complete the contour line 

setting and registration mark creation procedures.  

 
 

When you apply the “Multiple 

Copies” function, the value that 

has been set in this section will 

still be applied. 

Segmental Positioning 

X axis 

Y axis 
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Step 2 Click on the Set Jog Marks icon on the GreatCut toolbar and 4 marks will be created as 

shown in the picture below. 
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Step 3 Select both the entire object (including registration marks and the contour line) and press 

the Cut icon on the GreatCut toolbar. 

 
 

Step 4 The system will activate GreatCut automatically and import the registration marks and 

contour line to GreatCut. 
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Step 5 Select Output under File. 

 

 

Step 6 Select Mode as “Cut with AAS” and input the Number of outputs in X-direction and 

Y-direction and Distance between copies, please don’t press output button. 

 
 

Step 7 Back to CorelDRAW, Click Multi-Copy on GreatCut under File. 
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Step 8 Complete the Number in X/Y (the number of copies desired on the X/Y axis) and 

Distance in X/Y (distance between each copy) settings then click OK. Confirm that the 

value of Distance in X/Y must be the same with step 6. 

 

 

Note: The spacing of vertical & horizontal (Offset X & Y) should be ≥ 20mm or = 0mm; users are 

advised to set the Distance in X/Y as 0 mm to remove the space between each copy to 

avoid the waste of materials. 

 

Step 9 The system will create several copies of the object with registration marks as shown in 

the picture below. 
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Step 10 Print the Multi-Copy images out, and put the printed media on the GCC cutting plotter. 

 
 

Step 11 Go to GreatCut window, press Output button. 
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Edit your image in Adobe Illustrator 
 

 

4-Point Positioning  

 

Step 1 Create a new file in Adobe Illustrator.  

 
 

Step 2 Select the image and go to Contour in GreatCu in File. 
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Step 3 Complete contour line settings (including contour offset value) and press Calculate to 

confirm. 

 
 

 

Contour line is now added to the object. 

 

 

Contour offset is the distance 

between the object and the 

contour line. 
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Tips: Vector object to create round outline 

 

In general for vector objects you will get better results with the outline function. You will 

see the difference between "Normal" and "Round" in sharp corners. The picture is shown 

as below: 

   

 

 

1. Select the “Outline” in GreatCut option under File to create contours in a freely 

definable distance around text objects. 

  
 

2. Select “Round corners” and set the value of “offset” and “tolerance.” 

Offset is the value for the distance of the inline and outline from the original object. 

The field tolerance indicates in which offset from the corner dot is cut respectively 

rounded. 

 

 

 

Step 4 Click Settings on GreatCut under File. 

Normal Round 
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Step 5 Press the button on the right of Jog marks. 
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Step 6 Adjust the size, object margin and line thickness of your registration marks and click OK. 

 

 
 

 

 

 

 

Step 7 Ensure the three items below are selected and click OK. 

  
 

 

4-Point Positioning 

 Size: The length of marks 

 Range: 5mm~50mm 

 Optimized Setting: 25mm 

          Object margin: The distance  

between marks and images 

 Range: 0mm~50mm 

 Optimized Setting: 5mm 

  Line thickness: the line thickness 

of marks 

 Range: 1mm~2mm 

 Optimized Setting: 1mm 
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Step 8 Click Set Jog Marks on GreatCut under File. 

 

 

The system will create the 4 marks as shown in the picture below. 
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Output 

Step 1 Select both the entire object (including registration marks and the contour line) then click 

Cut on GreatCut under File. 

 
Step 2 The system will activate GreatCut automatically and import the registration marks and 

contour line to GreatCut. 
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Step 3 Select Output under File. 

 
 

Step 4 Select Cut with AAS in Mode/Tool in the Output to device window. 
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Step 5 Click output and the object will be sent to GCC Cutting Plotter 
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Note: The difference amount Number of outputs, Number of copies, and Step count in the 

Output window. 

 

 

 
1. When Number of outputs is set as 2, the square and the triangle will be cut 1 time 

and then the square and the triangle will be cut 1 time at next position. 

 

2. When Number of copies is set as 2, the square and the triangle will be cut 2 times at 

the same position. 

 

3. When Step count is set as 2, the square will be cut 2 times at the same position and 

then the triangle will be cut will be cut 2 times at the same position. 
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Advanced Settings 
 

Segmental Positioning 

For precise cutting quality, it is suggested to apply “Segmental Positioning” by adjusting the x 

and y distance when you are working on an extra long or large-size image to increase cutting 

quality. 

 

Follow the same steps in the 4-Point Positioning section to complete the contour line setting 

and registration mark creation procedures. Adjust the size, object margin and line thickness of 

your registration marks and the space between registration marks by changing X, Y distance in 

the Setup-Jog Marks window and click OK. 

 

Step 1 Click Settings on GreatCut under File. 
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Step 2 Press the button on the right of Jog marks. 

  
 

Step 3 Adjust the size, object margin and line thickness of your registration marks and click OK. 

 
 

 

 

 

 

 

 

Segmental Positioning 

 Max. x Distance: The distance of 

intermediate position on the X axis 

     Range: 200-500 mm 

 Max. y Distance: The distance of 

intermediate position on the Y axis 

     Range: 200-500 mm 
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Step 4 Select the Set Jog Marks on GreatCut under File and 4 marks will be created as shown in 

the picture below. 

 
 

 
 

Segmental Positioning 

X axis 

Y axis 
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Multi-Copy 

 

Step 1 Follow the same steps in the 4-Point Positioning section to complete the contour line 

setting and registration mark creation procedures.  

 
 

Step 2 Select the Set Jog Marks on GreatCut under File and 4 marks will be created as shown in 

the picture below. 

 

When you apply the “Multiple 

Copies” function, the value that 

has been set in this section will 

still be applied. 
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Step 3 Select both the entire object (including registration marks and the contour line) then click 

Cut on GreatCut under File. 
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Step 4 The system will activate GreatCut automatically and import the registration marks and 

contour line to GreatCut. 
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Step 5 Select Output under File. 

 

 

Step 6 Select Mode as “Cut with AAS” and input the Number of outputs in X-direction and 

Y-direction and Distance between copies, please don’t press output button. 
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Step 7 Back to Adobe Illustrator, Click Multi-Copy on GreatCut under File. 

 

 

Step 8 Complete the Number in X/Y (the number of copies desired on the X/Y axis) and 

Distance in X/Y (distance between each copy) settings then click OK. Confirm that the 

value of Distance in X/Y must be the same with step 6. 

 

 

Note: The spacing of vertical & horizontal (Offset X & Y) should be ≥ 20mm or = 0mm; users are 

advised to set the Distance in X/Y as 0 mm to remove the space between each copy to 

avoid the waste of materials. 
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Step 9 The system will create several copies of the object with registration marks as shown in 

the picture below. 

 

 

Step 10 Print the Multi-Copy images out, and put the printed media on the GCC cutting plotter. 
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Step 11 Go to GreatCut window, press Output button. 
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SignPal Instruction 
 
The SignPal Software is Windows System compatible and all versions support the AAS II 
contour cutting function.  
 
SignPal Instruction Index: 
[1] Installing the SignPal software 
[2] Set up your GCC Cutter on Production Manager 
[3] SignPal AAS II Quick Start 
[4] SignPal Features List 
 
 [1] Installing the SignPal software 
To install the software, you must have Administrator privileges. To use the software, you 
must have Administrator or Power User privileges. See your Windows user guide for more 
information. 
 
1. Uninstall any previous version of the software. 

 
2. Visit GCC website (https://www.gccworld.com/download.php?act=view&id=20) to 

download the WinRAR file. 
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3. Follow the installation and activation instruction for SignPal below. 
 
 
(1) Install and activate software on an online computer 
 
1. Launch your browser and type https://www.saicloud.com in address bar and press 

enter, then input your activation code, then click Activate, activation code can be 
found in the code label in software package. 

 
 
 
 
 
 
 
 
 
 
 

 
2. In login section, click I am new to the SAi Cloud and input your email address, 

then click Create Account, an email will be sent to your mailbox.
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3. Check your mailbox and click website link in the email then complete the 
information fields. 
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4. Open Autorun in the WinRAR file. Then install software step by step by following 
the wizard. 
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5. Paste your code into activation code field. 

 
6. Select language you need, click OK and finish installation. 
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(2) Install and activate software on an offline computer 
 

1. Open Autorun in the WinRAR file. Then install software step by step by following 
the wizard. 
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2. Record your computer ID in the dialog box below and look up your computer name, 

You can find your computer name by right-click on My Computer and choose 
Properties. 

 

  
 
 
3. Launch your browser on another online computer and type 

https://www.saicloud.com in the address bar and press enter, then input your 
activation code and click Activate. 
The Activation code can be found in the software package certificate. 
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4. In login section, click I am new to the SAi Cloud and input your email address, 
then click Create Account, an email will be sent to your mailbox. 

 

 
 
 

5. Check your mailbox and click website link in the email then complete the 
information fields. 
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6. Click “License Manager” can’t connect and input your computer ID and 
computer name that you recorded for the offline computer before, then click 
Create license Now and Download License, save license file to local. 
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7. Copy license file to offline computer via a removable disk device, then import it. 

 

 

8. Select language you need, then click OK and finish installation. 
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(3) Transfer license on an online computer 

 

1. Open License Manager from Start menu. 

 

2. Click Remove License From This computer, Now you can install the software 

on another computer. 
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(4)Transfer license on an offline computer 

1. Open License Manager from Start menu. 

 

2. Click Remove License From This computer, then record removal code in license 

dialog box. 

 
 

3. Launch your browser on another online computer, access 

https://www.saicloud.com and login with your account. Click License Removed 

then input removal code and click Remove. After this you can install software on 

another computer. 
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 [2] Set up your GCC Cutter on Production Manager 

 

1. Open Production Manager 12  

2. Choose and set up your GCC cutter. 

(Note that AAS II System only works on RX II, Jaguar V LX, Puma III, Expert II LX 

models.) 
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3. Select File > Print Setup in SignPal Software and select the printer. 
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4. Select File > Document Setup in SignPal and select paper size . 
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 [3] SignPal AASII Quick Start 

 

1. Use the Rectangle Tool to create a rectangle. 

 
 

2. Select Effect > Contour Cut. Then click ‘Apply’ in DesignCentral window. 
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3. Apply the contour cut mark of GCC AASII by selecting Effect > Contour Cut Mark.  

 

 

4. Select “GCC AASII” in SignPal DesignCentral window to create the AAS II registration 

marks (4-Point Positioning) and click ‘Apply’ in DesignCentral window.  
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5. There are three types of GCC AASII registration marks: 4-Point Positioning, Segmental 

Positioning, and Multiple Copies. To make ‘Segmental Positioning’ marks, please 

select “GCC Segmentation” in DesignCentral window and then click ‘Apply’.  

 
 

6. For ‘Multiple Copies’, this function is not available in SignPal. Currently the ‘Multiple 

Copies’ function is only available under CorelDraw plug-in. 

 

7. Select File > Print to print out the image. 
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8. Set the Scale as 100% in Print page. 

 

 

9. Load the printout vinyl on the plotter and select File > Cut Contour to send data. You 

can preview the job and change cutter’s parameter settings in ‘Properties’ tab of Cut 

Contour window. The Production Manager will be automatic activated to complete the 

job. 
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 [4] SignPal Features List 

 Expert Apprentice 

Text   

Text Tool ● ● 

Arc Text ●  

Path Text ●  

Vertical Text ● ● 

Vertical Path Text ●  

Kerning ●  

Break Apart/ Join ● ● 

   

Drawing   

Bezier ● ● 

Freehand Drawing ● ● 

   

Shapes   

Rectangle ● ● 

Oval ● ● 

Registration Mark Tool ● ● 

Measure Tool ● ● 

   

Path Editing   

Select Point Tool ● ● 

Remove Point ●  

Add Point ●  

Straighten Path ●  

Round Corner ●  

Sharpen Corner ●  

Optimize by Curve ●  

Optimize by Smooth 

Arc ●  

Optimize by 3point Arc ●  

Make Arc ●  

Reduce Points ●  

Close Path ●  

Change Start Point ●  

Cleaver ●  
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Scissors ●  

Make Right Angle ●  

Break Path ●  

Join Paths ●  

Align Horizontal ●  

Align Vertical ●  

Align Points ●  

Apply Length and 

Angle ●  

Remove Tiny Objects ●  

Vector Eraser ●  

Cleaver by Path ●  

   

Working with Files   

Job Info ●  

Scanning ●  

Achieve to Cloud ● ● 

Workspaces ● ● 

   

View   

DesignCentral ● ● 

Color Mixer ● ● 

Snap ● ● 

   

Arrange   

Group ● ● 

Compound ● ● 

Mask ● ● 

Guides ● ● 

Contour Cut ● ● 

Convert to Outlines ● ● 

Convert Stroke to 

Outlines ● ● 

Convert Linked to 

Native ● ● 

Path Direction ● ● 

Order ● ● 

Cut Order ● ● 
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Align ● ● 

Spacing ● ● 

Rotate ● ● 

Resize ● ● 

Deskew ● ● 

Mirror ● ● 

Step and Repeat ●  

   

Effects   

Combine ●  

Outline ●  

Contour Cut ● ● 

Contour Cut Mark ● ● 

Shadow ●  

   

Bitmap   

Autotrace ●  

Color Mode ●  

   

Production    

Cut/Plot ● ● 

Manual Split Lines ● ● 

Tile All Copies ● ● 

Panel to Border ● ● 

Auto-weld ● ● 

Auto-trap ● ● 

Overcut ● ● 

Optimize Cutting Order ● ● 
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Sure Cuts A Lot 

 

There are basic instructions of Sure Cut A Lot below. If you need detailed instruction, please 

refer to Sure Cut A Lot Help.  

 

1. Select the cutter you want to output and change the work area. 

 

Step 1 Run Sure Cuts A Lot software. 

  

 

Step 2 Select “Cutter” and select “Manage Cutters” under My Cutter to change the work 

area. 
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Step 3 Select company / brand as GCC and select model you want to output and then click 

the “<--Add to list” button. 

 
 

Step 4 Select GCC on the left and click “Done.” 

 

Step 5 If you want to change the material size and orientation, you can fill a proper value in 

the Document window.  
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2. Insert Graphics from Library  

Step 1 Select graphics from library to insert a selected design. 

 
 

3. Draw Text 

Click on the T icon at left side to create the text and select the font you like at text window.  
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4. Import Design 

If you have created your design in other design software, go to “import” or “place image” 

under file to import it, SCA supports svg, scut, scal, pdf, ai. wpc eps, bmp, gif, jpg and png 

files. 

 

 

 

 

 

 

 

 

 

 

 

 

Tips Thousands of SVG files designed specifically for Sure Cuts A Lot! 

 http://SVGCuts.com is the top of source for designer SVG files for Sure 

Cuts A Lot. Thousands of high quality elements including: shapes for 

card-making, scrapbooking, as well as gift bags, boxes and 3D flowers. 
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5. Convert Image to Cutting File 

Step 1 Go to Trace Image under File, or select Trace Image button on the toolbar to open 

the setting window. 

 

 

Step 2 Click on “Choose an image” to input the image, adjust Image Settings and Output 

Settings, and click OK. Then the outline of the image will be outputted automatically. 

 
 

 

 

 

 

 

Note 

 The contrast and pixels of import images will affect the trace 

image result. High contract graphics are recommended. 
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6. Cut the Design 

Step 1 Click on the “Cutter” button on the toolbar and Cut Settings window will appear. 

 
 

Step 2 Click on “Settings…” to open GCC Cutter Settings window. 

 

 

 

 

 

Step 3 Adjust Registration Marks setting under GCC Cutter Settings window if needed.  

 
 

 

 

 

*Registration Marks: set the distance between the edge of the material 

and the registration marks in Mark Offset; set the size of marks in Mark 

Size; set the line thickness of marks in Mark Thickness. 

 

Note 

 The origin point is on the bottom right. 
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Step 4 Adjust Blade Offset, Overcut Value, Multi-Cut and Quality under Cut Settings window 

if needed.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

*Blade Offset: set the offset value according to different blade, for a 

standard blade, set the offset value at 0.25mm, 0.5mm for an optional 

advanced blade and 0mm for an optional plotting pen. 

  

*Quality: associated with the cutting result; please note the better 

cutting quality, the slower cutting speed. 

 

*Multi-Cut: to repeat the cutting job at same position which is suitable 

for cutting thick material. 

 

*Overcut: allows for easier weeding and makes up for incomplete cut 

lines. 
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Step 5 Under “Cut Settings” section, there are some useful functions. After setting the 

parameters, click on “Cut” to send the data to the GCC cutter and the GCC cutter will 

start the cutting job. 

    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

*Cut Mode: there are “WSIWYG” and “Origin Point” options, WSIWYG 

means what you see is what you get, the cutter will output the graphic 

at same position in preview window. While with Origin Point mode, the 

cutter will cut the graphic from bottom right origin point of the material.  

 

*Use Software Speed and Pressure: tick this section, and you can set 

the values of speed and pressure manually.  

 

*Preset: select a proper material to apply the preset speed and 

pressure parameter automatically. 

 

*Speed & Pressure: you may adjust values of speed and pressure 

manually to get quality results. 
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7. Print and Cut Your Design 

The Print and Cut function allows you to print the graphics from Sure Cuts A Lot to printer, 

and then put the printed materials on the GCC cutter to cut out the contour of printed jobs 

from Sure Cuts A Lot.  

 

Step 1 Open an image file in Sure Cuts A Lot.  

 
 

Step 2 Click on the Cutter icon on the toolbar, set the parameters and click on “Print+Cut” to 

add the registration marks and print out the image. 
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Step 3 Click on “Print…” to open printer setting window and click OK. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4 Print your design with registration marks out.  

 
 

Step 5 Load the printed media to the GCC cutter. 

 

Step 6 Press “Next” and then press “Scan+Cut”, and then the GCC cutter will detect the 

registration marks and cut the contour lines automatically. 
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Tips Test Connection function can save your materials. 

 Click on “Test Connection” to exam if set the connection properly.  


